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Warranty Information
Your IOtech warranty is as stated on the product warranty card.  You may contact IOtech by phone,
fax machine, or e-mail in regard to warranty-related issues.
Phone: (440) 439-4091,  fax:  (440) 439-4093,  e-mail: sales@iotech.com

Limitation of Liability
IOtech, Inc. cannot be held liable for any damages resulting from the use or misuse of this product.

Copyright, Trademark, and Licensing Notice
All IOtech documentation, software, and hardware are copyright with all rights reserved.  No part of this product may be
copied, reproduced or transmitted by any mechanical, photographic, electronic, or other method without IOtech’s prior
written consent.  IOtech product names are trademarked; other product names, as applicable, are trademarks of their
respective holders.  All supplied IOtech software (including miscellaneous support files, drivers, and sample programs)
may only be used on one installation.  You may make archival backup copies.

FCC Statement
IOtech devices emit radio frequency energy in levels compliant with Federal Communications Commission rules (Part 15)
for Class A devices.  If necessary, refer to the FCC booklet How To Identify and Resolve Radio-TV Interference Problems
(stock # 004-000-00345-4) which is available from the U.S. Government Printing Office, Washington, D.C.  20402.

CE Notice
Many IOtech products carry the CE marker indicating they comply with the safety and emissions standards of the
European Community.  As applicable, we ship these products with a Declaration of Conformity stating which
specifications and operating conditions apply.

Warnings, Cautions, Notes, and Tips
Refer all service to qualified personnel.  This caution symbol warns of possible personal injury or equipment damage
under noted conditions.  Follow all safety standards of professional practice and the recommendations in this manual.
Using this equipment in ways other than described in this manual can present serious safety hazards or cause equipment
damage.

This warning symbol is used in this manual or on the equipment to warn of possible injury or death from electrical
shock under noted conditions.

This ESD caution symbol urges proper handling of equipment or components sensitive to damage from electrostatic
discharge.  Proper handling guidelines include the use of grounded anti-static mats and wrist straps, ESD-protective
bags and cartons, and related procedures.

This symbol indicates the message is important, but is not of a Warning or Caution category.  These notes can be of
great benefit to the user, and should be read.

In this manual, the book symbol always precedes the words “Reference Note.”  This type of note identifies the location
of additional information that may prove helpful.  References may be made to other chapters or other documentation.

Tips provide advice that may save time during a procedure, or help to clarify an issue.  Tips may include additional
reference.

Specifications and Calibration
Specifications are subject to change without notice.  Significant changes will be addressed in an addendum or revision to
the manual.  As applicable, IOtech calibrates its hardware to published specifications.  Periodic hardware calibration is
not covered under the warranty and must be performed by qualified personnel as specified in this manual.  Improper
calibration procedures may void the warranty.

Quality Notice
IOtech has maintained ISO 9001 certification since 1996.  Prior to shipment, we thoroughly test our products and
review our documentation to assure the highest quality in all aspects.  In a spirit of continuous improvement, IOtech
welcomes your suggestions.



Your order was carefully inspected prior to shipment.  When you receive your system, carefully
unpack all items from the shipping carton and check for physical signs of damage that may have
occurred during shipment.  Promptly report any damage to the shipping agent and your sales
representative.  Retain all shipping materials in case the unit needs returned to the factory.

CAUTIONCAUTIONCAUTIONCAUTION

Using this equipment in ways other than described in this manual can cause
personal injury or equipment damage.  Before setting up and using your
equipment, you should read all documentation that covers your system.
Pay special attention to Warnings and Cautions.

Note: During software installation, Adobe® PDF versions of user manuals will
automatically install onto your hard drive as a part of product support.  The default
location is in the Programs group, which can be accessed from the Windows
Desktop.  Initial navigation is as follows:

Start [Desktop “Start” pull-down menu]
⇒⇒⇒⇒ Programs

⇒⇒⇒⇒ Iotech DaqX Software

You can also access the PDF documents directly from the data acquisition CD by
using the <View PDFs> button located on the opening screen.

Refer to the PDF documentation for details regarding both hardware and software.

A copy of the Adobe Acrobat Reader® is included on your CD.  The Reader provides
a means of reading and printing the PDF documents.  Note that hardcopy versions of
the manuals can be ordered from the factory.

PDF
491-0901

PersonalDaq_UsersManual.pdf
Contains the Personal Daq hardware-related and software-related chapters, as well
as a link to the following .pdf file.  This pdf file, plus the following constitute a
complete set of documentation for the Personal Daq Devices.

PDF
1086-0926
1086-0922

PostAcquisition Analysis.pdf
This pdf consists of two documents.  The first discusses eZ-PostView, a post data
acquisition analysis program.  The application is included free as a part of
DaqTemp product support.  The second includes information regarding eZ-
FrequencyView and eZ-TimeView.  These two applications have more features than
does eZ-PostView and are available for purchase.  They can; however, be used
freely during a 30-day trial period.

PDF
491-0905

Personal DaqViewXL.pdf
This pdf discusses Personal DaqViewXL, optional software that allows Personal
DaqView and Personal DaqView Plus to execute functions from within Microsoft
ExcelTM
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Personal Daq   Quick Start

CAUTIONCAUTIONCAUTIONCAUTION
When using Personal Daq modules to acquire data, computer energy save modes can cause false
data readings.   Prior to using Personal Daq modules, ensure your computer’s energy save mode
is disabled.  If needed, consult your PC user’s manual to disable energy save (power suspension)
modes.

(1) Install Software

➣ IMPORTANT:  Software must be installed before installing hardware.

➣ If you purchased software, for example, Personal DaqViewXL or eZ-TimeView, an
associated authorization code(s) will accompany your order.  If this is the case, keep
your codes in a safe place.  You will need to enter them once, prior to the initial run of
that application.

➣ Remove any previously installed versions of Personal DaqView before installing a new
version.

For successful operation, your computer should conform to the following, as a minimum:

• PC system with Pentium processor
• Available USB port
• Microsoft Windows 98SE (Second Edition), WindowsMe/2000 or /XP
• 16 Mbytes of RAM (32 Mbytes, or greater, is recommended)
• Energy Save modes disabled (see the above Caution)

After reviewing the previous Caution, Notes, and ensuring that your computer meets or exceeds the
minimum requirements, perform the installation according to the following steps:

1. Remove previous version Daq drivers, if present.  You can do this through Microsoft’s
Add/Remove Programs feature.

2. Place the Data Acquisition CD into the CD-ROM drive. Wait for PC to auto-run the CD.
This may take a few moments, depending on your PC.  If the CD does not auto-run, use the
Desktop’s Start/Run/Browse feature.

3. After the intro-screen appears, follow the screen prompts.
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Installing Personal DaqViewXL

Personal DaqViewXL is an Excel-based application that is available as a purchased-option.  To install a non-trial
version of the application you will need an authorization code.  The code is provided at the time of purchase.  To
install the application:

1. Run Personal DaqView.

2. Select Authorization from the File pull-down menu.  An Authorization dialog box will appear.

3. Type in the code, as it appears on your Authorization Sheet.

4. Click the <Apply Code> button.

Refer to the associated document, 491-0905, Personal DaqViewXL User’s Guide, for additional information
regarding Personal DaqViewXL.

Installing a Post Acquisition Data Viewing Application

The eZ-PostView application is included free with your software package.  However, two other view programs, with
additional features, are available for purchase.  These are eZ-TimeView and eZ-FrequencyView.  The document
entitled eZ-Analyst Series Software Reference (p/n 1086-0922) contains detailed information regarding these
applications.

When eZ-PostView is about to be installed, an authorization box will appear, allowing you to install one of the
purchased options [providing you have an appropriate code].  You do not need a code to install eZ-PostView.
In this case, simply proceed without entering a code and eZ-PostView will automatically install.

To install eZ-TimeView or eZ-FrequencyView, enter the applicable code as it appears on your Authorization Sheet;
then click the <Apply Code> button.

Note that you can install a purchased view application at a later time, as follows:

1. Run eZ-PostView.

2. Select Authorization from the File pull-down menu.  An Authorization dialog box will appear.

3. Type in the code, as it appears on your Authorization Sheet.

4. Click the <Apply Code> button.

Reference Notes:

➣ Adobe Acrobat PDF versions of documents pertaining to Personal Daq are automatically installed onto
your PC’s hard-drive as a part of product support at the time of software installation.  The default
location is the Programs group, which can be accessed via the Windows Desktop Start Menu.

➣ Personal Daq documentation can be read directly from your data acquisition CD.  After placing the CD
in the CD-ROM drive simply click the <VIEW PDFS> button on the opening screen and select the
desired PDF from the pull-down list.

After completing the software installation, continue with section 2, Install Hardware.
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(2) Install Hardware
Depending on your order, your Personal Daq unit may not require all the steps under this heading; for
example: if you did not order a PDQ expansion module you would not connect one.  If a step does not apply
to your unit, simply go on to the next one.

+

  Ext. Pwr.

  6-16 V 
  500 mA Max.

 USB  Status

 Active
Ready

 Off

Personal Daq/56 Personal Daq/55 with PDQ2 Expansion Module

Label Slot
(1 of 2)

Expansion Module
(Optional)

Locking Clip
(1 per side)

User Customized Label

Connect High-Speed USB Cable
from host computer to the 
Personal Daq USB port.

Note:  The external power port is not used
            for the simple system setup discussed
            in this chapter.  Refer to Chapter 3 
            for examples of multiple-unit systems
            that make use of this connector.

Screw Terminal Block
(Removable)

Shaded cells of label
extend from slot for
easy removal.

Reference Notes:

➣ If you plan to mount your Personal Daq system to a DIN rail, refer to the PDQ10, DIN Rail Kit
Installation Guide (p/n 491-0903).  Note that the DIN rail instruction is also provided in your Personal
Daq User’s Manual, included in Acrobat .pdf format on your installation CD.

➣ If you are expanding your Personal Daq system with an optional PDQ expansion module, refer to the
PDQ1 and PDQ2 Installation Sheet (p/n 491-0902).  Expansion module information is also provided in
your Personal Daq User’s Manual, included in Acrobat .pdf format on your installation CD.

(2a) Connect the Personal Daq to the Host PC
When using a power adapter with your Personal Daq system, be sure to supply power (from the
adapter to the Personal Daq) before connecting the USB cable.  This allows Personal Daq to inform
the host computer (upon connection of the USB cable) that the unit requires minimal power from
the computer.

Use an approved high-speed USB cable to connect the Personal Daq system to one of the host computer’s
USB ports.  There is no need for an additional power source in this setup since the power pins (of the PC’s
USB connection) supply 500 mA at 4 to 5.25 V.  Additional setup examples, involving USB hubs and
power adapters, are described in chapter 3 of the user’s manual.

Personal Daq

USB Cable

PDQ Module

Connection of Simple Personal Daq System to Computer USB Port

Some notebook PCs do
not supply sufficient
power through their USB
port.  When using one of
these notebooks, the
Personal Daq unit
requires the use of a
power adapter.
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(2b)  Connect the Channel Signal Inputs

CAUTIONCAUTIONCAUTIONCAUTION
The discharge of static electricity can damage some electronic components.
Semiconductor devices are especially susceptible to ESD damage.  You should always
handle components carefully, and you should never touch connector pins or circuit
components unless you are following ESD guidelines in an appropriate ESD controlled
area.  Such guidelines include the use of properly grounded mats and wrist straps, ESD
bags and cartons, and related procedures.

Use Personal Daq’s screw terminals to connect channel inputs to your Personal Daq system. The terminal
blocks are detachable for ease in making connections.  The main module (Personal Daq/55 and Personal
Daq/56) and optional PDQ expansion modules (PDQ1 and PDQ2) have labels which clearly identify each
input type and channel number.  Each Analog Input channel can be configured for single-ended or
differential volts, or for differential thermocouple inputs.   The non-analog channels are designated as
Frequency/Pulse Input (F) and Digital I/O (D).

Reference Notes:
Connections for single-ended and differential modes are depicted in the figure on page 4.

Connecting Thermocouple Wires

In Personal Daq applications, thermocouples should not be connected single-ended.  Doing
so can result in noise and false readings.  This is especially true when acquiring other high-
amplitude signals in conjunction with thermocouple signals that are connected single-ended.

Thermocouple wires are to be connected in differential
mode only.  Differential connection is made as follows:

(a) the red wire connects to the channel’s Low (L)
connector.

(b) the second [color-coded] wire connects to the channel’s
High (H) connector.

The section entitled Signal Modes, in chapter 5 of the user’s
manual, contains additional information.

V

V

1

2

V
3

V
3+

V
3-

COM

V1 and V2 are
Single-Ended
Inputs

Personal Daq Terminal Block (Partial)

V3 is a Thermocouple
and is a Differential Input

L H

C
O
M HL

1 1 2 2

Single-Ended and Differential Connections
to Analog Input Channels

(3)  Start Personal DaqView
From Windows, open Personal DaqView by double clicking on the Personal DaqView icon, or by using the
Windows Desktop Start Icon to access the Personal DaqView program.   You will find Personal DaqView
listed in the desktop’s Program group.

Once the program is executed, the software identifies your Personal Daq device and brings up the Main
Control Window.  This window is discussed briefly in the following text, and in more detail in chapter 4 of
the Personal Daq User’s Manual that is included on the installation CD.
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(4)  Configure the System
This step pertains to the configuration of channels and acquisition parameters through Personal DaqView
software.  To configure a set of parameters, use the appropriate toolbar button (or the View pull-down
menu) to open the applicable window.  Clicking on the Configure Channel Settings button (9) brings up the
Channel Configuration Window.

Main Control Window

Channel Configuration Window, with Analog Input Spreadsheet Selected

Button Function

1 Open Configuration File Opens a selected configuration file.

2 Save Configuration File Saves the current configuration file to disk.

3 Select Active Device Provides a means of selecting active devices from the Personal Daq system.

4 Arm Trigger for Disk
Recording

Arms the trigger and stores acquisition data to a designated disk file.  If Auto Rearm
is selected, clicking this button puts Auto rearm in effect.  This button, is also used to
disarm the data acquisition.

5 Manual Trigger Used to trigger the device when the mode of trigger is set to “Manual.”  Note that the
Manual Trigger button can not be depressed until after the trigger is armed, for
example, by first pressing button 4.

6 Update Digital Outputs Updates digital outputs for all digital channels that are selected to “output state.” also
see Digital Input/Output Spreadsheet, in chapter 4 of the user’s manual.

7 Configure Data
Destination

Accesses the Configure Data Destination window.  Note that this window provides a
means of selecting sequential destinations through an auto rearm feature.

8 Configure Acquisition Accesses the Configure Acquisition window.

9 Configure Channel
Settings

Brings up the Channel Configuration window.  From this window you can configure
channels for Analog Input, Frequency/Pulse Input, and Digital Input/Output channels,
depending on which tab is selected.

10 Update All Indicators Starts all on-screen indicators with a display of up-to-date data. Has no affect on the
recording of data to disk.  Auto Rearm, even if selected, will not occur when using this
control.  This button is also used to pause all indicators.

11 Display Scrolling Charts Displays data graphically in a scrolling chart.

12 Display Bar Meters Displays data in a bar graph format.

13 Display Analog Meters Displays data displayed in a dial-gage format.

14 Display Digital Meters Displays data in a digital meter format.

15 View Data Launches an independent post-data acquisition program such as eZ-PostView, if
installed. The install CD includes a .pdf version of the eZ-PostView document.

16 Enable Readings
Column

Activates the Channel Configuration Window’s reading column.  Does not affect the
recording of data to disk.

17 Disable Readings
Column

Stops the Channel Configuration Window’s reading column.  Does not affect the
recording of data to disk.
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(4a)  Channel Configuration
The Channel Configuration Window first opens with the Analog Input screen selected.  You can change
from one configuration screen to another by selecting the appropriate tab.  More information regarding
Personal DaqView appears in chapter 4 of the user’s manual. You can configure channels from the three
configuration screens as indicated in the following table.

Channel Type User Configurable Parameters

Analog Input User Label, On, Range, Units, Single-Ended/Differential, Measurement Duration, Scale,
Offset

Frequency/Pulse Input User Label, On, Type, Units, Edge, Debounce, Min. Value, Max. Value,
Resolution (Settling Time), Scale, Offset

Digital Input/Output User Label, On, Input/Output, Output State, Power-Up State

Note:  With the mouse cursor positioned in the desired spreadsheet cell, you can:

“Single-click” with the left mouse button to open an associated pull-down list for the applicable cell, from which a
selection can be made.  This pull-down list appears just below the toolbar.

“Double-click” with the left mouse button to cycle through listed selections or write-enable a cell, as applicable.  If
the cell has a given parameter list (such as those in the On, Range, and Measurement Duration columns) the
parameter will change with each double-click, allowing you to cycle through all possible selections. Note that
these selections are repetitive; in other words, you will eventually advance to the same selection you started
with. “Type-in” cells (such as User Label, Scale, and Offset) can be selected on double-click for easy editing.

“Single-click” left, then “single-click” right to write-enable a cell.  Completing this action with the mouse buttons
(while having the cursor on a cell such as Scale or Offset) allows you to use you PC’s keypad to type the
desired value into the field.

“Single-click” left, “single-click” right, then “single-click” left again to open an associated pull-down list for the
applicable cell, from which a selection can be made.  This pull-down list appears in the selected cell’s row.

(4b)  Acquisition Configuration
To configure acquisition parameters, activate the Configure Acquisition Window by using the Configure
Acquisition button (8).

Configure Acquisition Window
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The Configure Acquisition Window has the following default settings.

Pre-Trigger:  No duration set, i.e., a duration of 0 scans
Trigger:  Immediate
Post Trigger:  Manual stop
Averaging: None
Acquisition Parameters:

Set for Maximum scan rate
Frequency: selected
Period: not-selected
Continuous Calibration: not-selected
Overrange Protection: selected

You can change the acquisition setup as desired.  Explanations of setup options are discussed in chapter 4
of the user’s manual.

Functions that can be obtained with Main Control Window toolbar buttons can also be obtained through
pull-down menus (discussed subsequently).  See chapter 4 of the manual for more detailed information.

(4c)  Data Destination Configuration
The Data Destination window can be accessed with the Configure Data Destination button (7).  From the
Data Destination window you can assign a filename and folder location for the acquisition data.  More
detailed information is provided in chapter 4 of the manual.

Data Destination Window

(5)  Collect Data
Press the Enable Readings Column button (16), or the Update All Indicators button (10) to start the
acquisition.  The data acquisition begins and the readings column becomes active.  However, data is not
recorded to disk.  Pressing the Arm Trigger for Disk Recording button (4) will send the data to disk.

Press one of the toolbar’s display icon buttons (11, 12, 13, or 14) to see your data in the form of a chart or
meter.  Display options are as follows: 11 − scrolling charts, 12 − bar graph meters, 13 − analog meters, and
14 − digital meters.  Note that you can view all display types, or a combination of them, at the same time.

Note 1:  For scrolling charts, a Chart Setup Wizard is used to set up the desired chart display.  Channels not
set up in the display can still be enabled and read on the Channel Configuration Window.

Note 2: Chapter 4 of the user’s manual is devoted entirely to the Personal DaqView program and its
Chart Setup Wizard feature.
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 A Brief Guide to Using Personal DaqView
Once your Personal Daq system has been properly connected to the PC and to the desired input signals, the following
steps may be used to start Personal DaqView and begin collecting data.  For this “Quick Start” approach to
collecting data we will be making use of the program’s default settings.

Note that acquisition settings can be changed from the Configure Acquisition Window.  This window is accessed via
the Configure Acquisition button (8).  For ease of reference, related screen captures have been provided below.

1. From Windows, open Personal DaqView by double-clicking on the Personal DaqView icon, or by using the
Windows Desktop Start Icon to access the Personal DaqView program.

Once the program is executed, the software identifies your Personal Daq device and brings up the Main Control
Window and Channel Configuration Window.  The Analog Input Spreadsheet will be selected by default.

Note:   If the Channel Configuration Window is not visible, click on the Configure Channel Settings button (9).

2. Select the desired spreadsheet, if other than Analog Input, by using the appropriate tab, i.e., Frequency/Pulse
Input, or Digital Input/Output.

3. Ensure the desired channels are enabled.  Positioning the cursor in a channel’s “On” column and double-clicking
enables a channel that was previously “Off.”

4. If you want to record data to disk, click on the Arm Trigger for Disk Recording button (4). The data acquisition
begins and data is stored to the disk file designated in the Data Destination Window.

5. To see real time readings on the Channel Configuration Window, click on the Update All Indicators button
(10), or on the Enable Readings Column button (16).

6. If you want to read data, but not record to disk, click on button 10 or 16, but do not click on button 4.  In
addition to the Channel Configuration Windows reading column, you can click on one or more display icon
buttons (11, 12, 13, or 14) to see your data in the form of a chart or meter.  You can view all display types, or a
combination of them, at the same time.  Display options, listed as button number followed by display type, are:
11 −−−− scrolling charts, 12 −−−− bar graph meters, 13 −−−− analog meters, and 14 −−−− digital meters.

Main Control Window*

Channel Configuration Window, with Analog Input Spreadsheet Selected*

*Button descriptions are provided on page 5 of this document.


